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Chapter 1

Welcome
About SMART Notebook™ Software
SMART Notebook collaborative learning software allows users to create interactive 
lesson materials and present them using a SMART Board™ interactive whiteboard or 
other computer system. With a rich set of design and delivery features as well as 
access to Gallery content, SMART Notebook connects you to content, tools and 
support for creating high-impact lessons and presentations. 

The SMART Notebook installation package (also known as an .msi file) includes the 
following components.

SMART Notebook Math Tools
SMART Notebook Math Tools is an add-in for SMART Notebook. It includes 
mathematical features such as equation editing, handwriting recognition for 
mathematical terms, additional shape tools, measurement tools, graph generation 
and a launcher for Texas Instruments™ (TI) emulators. A 30-day trial is included, and 
you can activate SMART Notebook Math Tools using a product key you receive from 
SMART Technologies or your reseller.

Gallery Content
The Gallery contains clip art, backgrounds, multimedia content, SMART Notebook 
files and pages that you can use in your presentations. The Gallery also provides 
access to online resources.

About SMART Product Drivers
SMART Product Drivers enables computers to work with SMART Board interactive 
whiteboards or other SMART products. The drivers include Floating Tools as well as 
other software tools you can use with your SMART products. SMART Product Drivers 
is a separate installation package.
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Handwriting Recognition Installation 
Packages
SMART Notebook supports handwriting recognition in English by default. If you want 
to support handwriting recognition in a language other than English, you must 
download and install the installation package for the language. For more information, 
see page 6.

About This Guide
This guide explains how to install SMART Notebook and SMART Product Drivers on 
your network computers and then configure and maintain the SMART Notebook 
installation.

This guide is intended for IT administrators and others experienced with installing, 
configuring and administering Windows® software in a networked environment. To 
use this guide, you must:

• Know IT terminology such as “registry” and “domain controller”.

• Know how to complete basic administrative tasks in Windows operating systems, 
such as opening Control Panel or modifying the registry.

• Have administrative privileges and access to your school’s servers.

• Have the SMART Notebook CD or access to the SMART Support website.
 



Chapter 2

Installing 
SMART Notebook
You can install SMART Notebook and SMART Product Drivers on your network 
computers using the installation wizard, the command line interface or SMART Install 
Manager (using Group Policy-based software deployment). Regardless of which tool 
you use, review the information in this chapter before proceeding with the installation.

Before Installing SMART Notebook
Before you install SMART Notebook, ensure your computers meet the hardware and 
software requirements defined in SMART Notebook 10 for Windows and Mac 
computers release notes (smarttech.com/kb/126571).

When you install SMART Notebook, Windows Installer checks the computer for 
existing instances of SMART Notebook or SMART Product Drivers. If Windows 
Installer finds instances of either software, it removes that software, and then installs 
the new version.

IMPORTANT
• If you have SMART Board software 9.0 or earlier on your computers, you 

have to remove it manually. For more information, see Removing Previous 
Versions of SMART Notebook on page 61.

• If you choose not to install a specific program but there is an existing instance 
of that program on the computer, Windows Installer removes the program and 
does not reinstall it.
 

http://downloads.smarttech.com/media/sitecore/en/support/product/smartnotebook/smartnotebooksoftware10windows/releasenotes/relnotesnotebook10winmacv02september10.pdf
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Selecting a Tool
You can customize the SMART Notebook installation packages using one of the 
following tools:

• Installation wizard

• Command line interface

• SMART Install Manager

Use the installation wizard if you’re installing SMART Notebook on a small number of 
computers or if users are responsible for installing software on their own computers.

Use the command line interface if you prefer to install software using a command line 
interface rather than a GUI installation wizard, or if you use Windows Installer in 
conjunction with third-party remote management software to automate the installation 
of software across your network. For more information, see Using the Command Line 
Interface on page 7.

Use SMART Install Manager if you’re deploying the software across a large network of 
computers and you prefer to use SMART Install Manager, rather than a command line 
interface, to customize the installation packages. You can then use third-party 
software to automate the installation across your network. For more information, see 
Using SMART Install Manager on page 23.

Locating the Installation Packages
There are four installation packages (also known as .msi files) for SMART Notebook.

IMPORTANT
Install the Microsoft Visual C++ 2008 SP1 redistributable package before installing 
SMART Product Drivers.

Installation Package File Name

SMART Notebook SMART Notebook.msi

Microsoft® Visual C++® 2008 SP1 
redistributable 

vc_red.msi

SMART Product Drivers SMART Product Drivers.msi

Adobe® Flash® Player ActiveX® 
control

install_flash_player_10_active_x.msi
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NOTE
The Microsoft Visual C++ 2008 SP1 and Adobe Flash Player ActiveX control 
.msi files are new in SMART Notebook 10.6 software.

The installation packages are located on the SMART Notebook CD.

Alternatively, you can download the packages from smarttech.com/SupportNB10Win.

Locating Language Files
If you’re planning to install SMART Notebook or SMART Product Drivers in a 
language other than English (U.S.), ensure the corresponding .mst file for that 
language is in the same folder as the .msi file.

The .mst files are available from the same locations as the .msi files.

File Language File Language

1033.mst English (U.S.) 1038.mst Hungarian

2057.mst English (UK) 1040.mst Italian

1025.mst Arabic 1041.mst Japanese

1069.mst Basque 1042.mst Korean

1027.mst Catalan 1044.mst Norwegian

2052.mst Chinese (simplified) 1045.mst Polish

1028.mst Chinese (traditional) 2070.mst Portuguese (Portugal)

1050.mst Croatian 1046.mst Portuguese (Brazil)

1029.mst Czech 1048.mst Romanian

1030.mst Danish 1049.mst Russian

1043.mst Dutch 3098.mst Serbian

1035.mst Finnish 1051.mst Slovak

3084.mst French (Canada) 1060.mst Slovenian

1036.mst French (France) 1034.mst Spanish (Spain)

1031.mst German 2058.mst Spanish (Mexico)

1032.mst Greek 1053.mst Swedish

1037.mst Hebrew 1055.mst Turkish
 

http://www.smarttech.com/us/Support/Browse+Support/Download+Software+Internal/SMART+Notebook+10_6+administrator+downloads/
http://www.smarttech.com/us/Support/Browse+Support/Download+Software/Software/SMART+Notebook+collaborative+learning+software/SMART+Notebook+software/SMART+Notebook+for+Windows
http://www.smarttech.com/us/Support/Browse+Support/Download+Software+Internal/SMART+Notebook+10_6+administrator+downloads/
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Handwriting Recognition Language Installation Packages
If you want to support handwriting recognition in a language other than English, you 
must download and install the installation package for the language.

You can download these packages from from smarttech.com/SupportNB10Win.

File Product Code Value

myscript hwr (arabic).msi {978A47F7-B01C-4E6B-8ED7-9C48DA5ED5D9}

myscript hwr (chinese).msi {1C08E9A9-AC34-41C1-82AE-28D052DBC500}

myscript hwr (danish).msi {5CAADAA8-39A6-44D4-A189-19A5DDB704AF}

myscript hwr (dutch).msi {FFE8B367-7349-406F-A583-F2795A0A0548}

myscript hwr (finnish).msi {7762637E-C185-4252-8FE9-72BC095AB47C}

myscript hwr (french).msi {9A960F35-C1DA-4FC0-B802-EAFF4179FDB0}

myscript hwr (german).msi {415CD877-0970-4CB6-B178-1E72F7DC60E7}

myscript hwr (greek).msi {DBBEDE5D-3342-4C13-ABA1-E35DA1147ED5}

myscript hwr (hungarian).msi {FB4F5116-0220-4296-B888-CBAFE6A6B9C0}

myscript hwr (italian).msi {0E5F9A13-4C27-4CE4-9E29-69223EE08FCF}

myscript hwr (japanese).msi {B693FD69-0E52-4BD6-B2BA-59EC10BB4BEF}

myscript hwr (korean).msi {5CBF713D-6EC6-4BDF-9B40-6338AC0D1C1A}

myscript hwr (norwegian).msi {12A35C25-B07E-4481-B1A0-B36892C07491}

myscript hwr (polish).msi {909E3219-72DE-40A3-9162-E653CBEBABF2}

myscript hwr (portuguese).msi {727822B6-9BF7-41C0-AB57-8EE6E21814D9}

myscript hwr (russian).msi {1F2282B4-7A07-4AD1-BFCF-C58F37E3EC2C}

myscript hwr (spanish).msi {EDAC6E0D-F93B-4B80-9377-F57D3BB5E6B1}

myscript hwr (swedish).msi {EB61ED3F-8C2F-4D3D-81BE-CA16DA87D515}

myscript hwr (turkish).msi {319B07E6-4D8A-4A7F-BC38-BA39C4BADF4F}
 

http://smarttech.com/us/Support/Browse+Support/Download+Software/Software/SMART+Notebook+collaborative+learning+software/SMART+Notebook+software/SMART+Notebook+for+Windows
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Using the 
Command Line 
Interface
The SMART Notebook installation package contains all of the information 
Windows Installer needs to install or remove the SMART Notebook components. Run 
the .msi files from a command prompt to start Windows Installer, and to install or 
modify the software using available properties and parameters.

IMPORTANT
• When you enter paths in the procedures below, use Universal Naming 

Convention (UNC) paths.

• If you use a Windows Vista® or Windows 7 operating system, you must open 
a Command Prompt window in Elevated mode with full administrator rights.

Installing the Software
You can install SMART Notebook, the Microsoft Visual C++ 2008 SP1 redistributable, 
SMART Product Drivers, the Adobe Flash Player plug-in and handwriting recognition 
in languages other than English by following the instructions in this section.

IMPORTANT
If you have SMART Product Drivers 10.6.106.1 or 10.6.175.2, install the Microsoft 
Visual C++ 2008 SP1 redistributable package before installing SMART Product 
Drivers.

To install
SMART Notebook

1. Open a Command Prompt window.

2. Type the following command (including quotation marks):

msiexec /i "[Path]\SMART Notebook.msi" [Properties] 
[Parameter] /qn
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Where:

– [Path] is the path to the SMART Notebook.msi file.

– [Properties] is a set of properties you can include to customize the installation 
(see page 10).

– [Parameter] is the installation parameter (see page 19).

3. Press ENTER.

Windows Installer installs or updates SMART Notebook software.

Install the Microsoft Visual C++ 2008 SP1 redistributable package before installing 
SMART Product Drivers.

To install the Microsoft
Visual C++ 2008 SP1

redistributable

1. Open a Command Prompt window.

2. Type the following command:

msiexec /i "[Path]\vc_red.msi" [Parameter] /qn

Where:

– [Path] is the path to the vc_red.msi file.

– [Parameter] is the installation parameter (see page 19).

3. Press ENTER.

Windows Installer installs the Microsoft Visual C++ 2008 SP1 redistributable.

To install or update
SMART Product Drivers

1. Open a Command Prompt window.

2. Type the following command:

msiexec /i "[Path]\SMART Product Drivers.msi" [Properties] 
[Parameter] /qn

Where:

– [Path] is the path to the SMART Product Drivers.msi file.

– [Properties] is a set of properties you can include to customize the installation 
(see page 10).

– [Parameter] is the installation parameter (see page 19).

3. Press ENTER.

Windows Installer installs or updates SMART Product Drivers.
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The Adobe Flash Player ActiveX control .msi file is a separate installation package 
required for several SMART Notebook software components. Follow the procedure 
below to install it.

To install the Adobe Flash
Player ActiveX control

1. Open a Command Prompt window.

2. Type the following command:

msiexec /i "[Path]\install_flash_player_10_active_x.msi" /qn 

Where [Path] is the path to the install_flash_player_10_active_x.msi file.

3. Press ENTER.

Windows Installer installs the Adobe Flash Player ActiveX control.

NOTE
This can take several minutes with no indication of activity or completion.

SMART Notebook and SMART Product Drivers include handwriting recognition in 
English by default. If you want to enable handwriting recognition in a language other 
than English, follow the procedure below.

To install handwriting
recognition in a language

other than English

1. Open a Command Prompt window.

2. Type the following command:

msiexec /i "[Path]\[File]" /qn

Where:

– [Path] is the path to the handwriting recognition .msi file.

– [File] is the name of the handwriting recognition .msi file for the desired 
language (see page 6).

3. Press ENTER.

Windows Installer installs handwriting recognition in the specified language.

NOTE
This can take several minutes with no indication of activity or completion.
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Properties
The following are general properties for the SMART Notebook installation package.

NOTE
For SMART Notebook’s Gallery properties, see Installing and Maintaining Gallery 
Content on page 33.

• INSTALLDIR 

NOTE
If you don’t include this property, Windows Installer installs the program in 
%PROGRAMFILES%\SMART Technologies\SMART Notebook.

• ISX_SERIALNUM 

• ACTIVATE_LICENSE

IMPORTANT
– You must enter the ISX_SERIALNUM property (above) for this property 

to work.

– For mass activation information including flags, see Mass Activation on 
page 57.

Value Enter this value to:

[String] Specify the path to your preferred folder for 
SMART Notebook.

Value Enter this value to:

[String] Specify the 22-character product key you received from 
SMART Technologies. 

NOTES
• This auto-populates the Product Key field in the 

activation wizard if you choose not to enter the 
ACTIVATE_LICENSE property (below).

• A SMART Notebook Math Tools product key 
activates both SMART Notebook and SMART 
Notebook Math Tools.
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• INSTALL_DOCCAM_DRIVERS 

• INSTALL_SPU 

IMPORTANT
If you want to customize SPU properties, you need to make the same 
customizations in both your SMART Notebook and SMART Product Drivers 
installations.

Value Enter this value to:

1 (Default) Register the product key and automatically activate the 
software.

NOTE
A SMART Notebook Math Tools product key activates 
both SMART Notebook and SMART Notebook Math 
Tools.

0 Register the product key but without automatically activating 
the software.

Value Enter this value to:

1 (Default) Enable the registration of SMART Document Camera 
drivers.

0 Disable the registration of SMART Document Camera 
drivers.

NOTE
Disable the registration of SMART Document Camera 
drivers if it conflicts with existing third-party drivers on 
the computer.

Value Enter this value to:

1 (Default) Install SMART Product Update (SPU).

0 Not install SPU.
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• SPU_TIME_FRAME 

NOTES
– By default, SPU checks for product updates every 30 days. You can set 

SPU to check for product updates at intervals of 1 to 60 days.

– This property is applicable only if you install SPU.

• PRODUCT_NOTIFICATION 

NOTE
This property is applicable only if you install SPU.

• PRINT_CAPTURE

• CREATE_DESKTOPICONS

• CUSTOMER_LOGGING

Value Enter this value to:

[Integer] Specify the time in days between SPU checks.

Value Enter this value to:

1 (Default) Notify the user when updates are available from SPU.

0 Not notify the user when updates are available from SPU.

Value Enter this value to:

1 (Default) Install Print Capture.

0 Not install Print Capture.

Value Enter this value to:

1 (Default) Create SMART Notebook desktop icons.

0 Not create SMART Notebook desktop icons.

Value Enter this value to:

0 Disable the Customer Experience Program.

1 (Default) Allow the user to enable or disable the Customer 
Experience Program.

2 Enable the Customer Experience Program.
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• NBPLUGIN_INSTALLED

IMPORTANT
If you have a security policy restricting the installation of any Internet 
Explorer® ActiveX plug-ins (32-bit operating systems), you need to include 
NBPLUGIN_INSTALLED=0 or the installation may not succeed.

• ENABLE_MATH_TRIAL

• TRANSFORMS

NOTE
The TRANSFORMS property defines the language of the installer’s user 
interface and the installed software’s icons and shortcuts. It doesn’t define the 
installed software’s user interface language. The installed software uses the 
computer’s operating system language if it’s supported, or English (U.S.) if 
not. For information on changing the user interface language, see Language 
Setup on page 55.

Value Enter this value to:

0 Install the NotebookPlugin.dll file without adding the 
associated registry keys.

1 (Default) Install the NotebookPlugin.dll file and add the associated 
registry keys.

Value Enter this value to:

1 (Default) Enable a 30-day trial of SMART Notebook Math Tools.

0 Disable the 30-day trial of SMART Notebook Math Tools.

Value Enter this value to install SMART Notebook in:

1033.mst English (U.S.)

2057.mst English (UK)

1025.mst Arabic

1069.mst Basque

1027.mst Catalan

2052.mst Chinese (simplified)

1028.mst Chinese (traditional)

1050.mst Croatian

1029.mst Czech

1030.mst Danish
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• ACC 

1043.mst Dutch

1035.mst Finnish

3084.mst French (Canada)

1036.mst French (France)

1031.mst German

1032.mst Greek

1037.mst Hebrew

1038.mst Hungarian

1040.mst Italian

1041.mst Japanese

1042.mst Korean

1044.mst Norwegian

1045.mst Polish

2070.mst Portuguese (Portugal)

1046.mst Portuguese (Brazil)

1048.mst Romanian

1049.mst Russian

3098.mst Serbian

1051.mst Slovak

1060.mst Slovenian

1034.mst Spanish (Spain)

2058.mst Spanish (Mexico)

1053.mst Swedish

1055.mst Turkish

Value Enter this value to:

0 Disable Internet access.

1 Enable Internet access only for Gallery Setup.

2 Enable Internet access only for Language Setup.

Value Enter this value to install SMART Notebook in:
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SMART Product Drivers
The following properties are available if you choose to install SMART Product Drivers 
(see page 8):

• INSTALLDIR 

NOTE
If you don’t include this property, Windows Installer installs the program in 
%PROGRAMFILES%\SMART Technologies\SMART Product Drivers.

3 Enable Internet access only for Gallery Setup and 
Language Setup.

4 Enable Internet access only for SPU.

5 Enable Internet access only for Gallery Setup and SPU.

6 Enable Internet access only for Language Setup and SPU.

7 Enable Internet access for everything except the Customer 
Experience Program.

8 Enable Internet access only for the Customer Experience 
Program.

9 Enable Internet access only for Gallery Setup and the 
Customer Experience Program.

10 Enable Internet access only for Language Setup and the 
Customer Experience Program.

11 Enable Internet access for everything except SPU.

12 Enable Internet access only for SPU and the Customer 
Experience Program.

13 Enable Internet access for everything except Language 
Setup.

14 Enable Internet access for everything except Gallery Setup.

15 (Default) Enable Internet access for everything.

Value Enter this value to:

[String] Specify the path to your preferred folder for SMART Product 
Drivers.

Value Enter this value to:
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• INSTALL_DOCCAM_DRIVERS 

• INSTALL_UNSIGNED_DRIVERS 

• CREATE_STARTUP_ICON

• TOOLS_STARTUP_GROUP 

Value Enter this value to:

1 (Default) Enable the registration of SMART Document Camera 
drivers.

0 Disable the registration of SMART Document Camera 
drivers

NOTE
Disable the registration of SMART Document Camera 
drivers if they conflict with existing third-party drivers on 
the computer.

Value Enter this value to:

1 (Default) Enable the registration of unsigned third-party drivers.

NOTE
If you enable the registration of unsigned third-party 
drivers, the installation process may ask users if 
they trust the makers of the drivers during 
installation. This can cause issues if you’re 
deploying the installation in Silent mode. Therefore, 
it is best to disable the registration of third-party 
drivers if you’re deploying the installation in Silent 
mode.

0 Disable the registration of unsigned third-party drivers. 

Value Enter this value to:

1 (Default) Create a SMART Product Drivers icon in your startup group.

0 Not create a SMART Product Drivers icon in your startup 
group.

Value Enter this value to:

1 (Default) Start SMART Tools when the user logs on.

0 Not start SMART Tools when the user logs on.
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• LAUNCH_BOARD_TOOLS 

• INSTALL_SPU 

IMPORTANT
If you want to customize SPU properties, you need to make the same 
customizations in both your SMART Notebook and SMART Product Drivers 
installations.

• SPU_TIME_FRAME 

NOTES
– By default, SPU checks for product updates every 30 days. You can set 

SPU to check for product updates at intervals of 1 to 60 days.

– This property is applicable only if you install SPU.

• PRODUCT_NOTIFICATION 

NOTE
This property is applicable only if you install SPU.

Value Enter this value to:

1 (Default) Start SMART Tools at the end of the installation.

0 Not start SMART Tools at the end of the installation.

Value Enter this value to:

1 (Default) Install SMART Product Update (SPU).

0 Not install SPU.

Value Enter this value to:

[Integer] Specify the time in days between SPU checks.

Value Enter this value to:

1 (Default) Notify the user when updates are available from SPU.

0 Not notify the user when updates are available from SPU.
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• ENABLE_TABLETPC_SUPPORT 

NOTE
This property is applicable only to Windows Vista and Windows 7 operating 
systems. It has no effect on other operating systems.

• START_SNMP_SERVICE 

NOTE
For more information on SMART SNMP Agent, see the SMART SNMP Agent 
Administrator’s Guide (smarttech.com/kb/128702).

Value Enter this value to:

1 (Default) Use Tablet PC functionality with the SMART Board 
interactive whiteboard without connecting a Tablet PC.

0 Not use Tablet PC functionality with the SMART Board 
interactive whiteboard without connecting a Tablet PC.

NOTE
If you specify 0 for this property, users won’t have touch 
support at the Windows logon screen.

Value Enter this value to:

1 Enable SMART SNMP Agent, allowing you to remotely 
monitor and control your SMART products and projectors 
from a shared location.

0 (Default) Disable SMART SNMP Agent.
 

http://downloads.smarttech.com/media/sitecore/en/support/product/installmanager/guides/snmpagentadminguidev04sept08.pdf
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Parameters
You can use the following parameters for the SMART Notebook and SMART Product 
Drivers installation packages.

NOTE
These are standard msiexec mode parameters.

Removing the Software
In addition to installing or upgrading SMART Notebook, SMART Product Drivers, the 
Microsoft Visual C++ 2008 SP1 redistributable, the Adobe Flash Player ActiveX 
control plug-in, and the handwriting recognition packages, you can remove them in 
Silent mode using Windows Installer.

Parameter Use this parameter to:

/q Hide the installation wizard.

NOTE
This is Silent mode.

/qb Show a basic installation wizard.

/qb! Show a basic installation wizard without a Cancel button.

/qb+ Show a basic installation wizard with a dialog box signaling the 
end of the installation.

/qb+! Show a basic installation wizard with a dialog box signaling the 
end of the installation, but without a Cancel button.

/qr Show a reduced installation wizard.

/qf Show the full installation wizard, including a dialog box signaling 
the end of the installation or the Fatal Error, User Exit or Exit 
dialog box.

/qn Hide the installation wizard and the dialog box signaling the end 
of the installation.

/qn+ Hide the installation wizard but show the dialog box signaling 
the end of the installation.
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To remove
SMART Notebook

1. Open a Command Prompt window.

2. Type the following command:

msiexec /x "[Path]\SMART Notebook.msi" /qn

Where [Path] is the path to the SMART Notebook.msi file.

OR

If you want to remove the file using the product code, type:

msiexec /x [Product Code] /qn 

Where [Product Code] is the product code value for the version of SMART 
Notebook you’re removing (see page 67).

3. Press ENTER.

Windows Installer removes SMART Notebook.

NOTE
This can take several minutes with no indication of activity or completion.

NOTE
If you’re using SMART Product Drivers 10.6.106.1 or 10.6.175.2 and have 
installed the Microsoft Visual C++ 2008 SP1 redistributable, you can remove the 
redistributable.

To remove the Microsoft
Visual C++ 2008 SP1

redistributable

1. Open a Command Prompt window.

2. Type the following command:

msiexec /x "[Path]\vc_red.msi" /qn

Where [Path] is the path to the vc_red.msi file.

OR

If you want to remove the file using the product code, type:

msiexec /x {9A25302D-30C0-39D9-BD6F-21E6EC160475} /qn 

3. Press ENTER.

Windows Installer removes the Microsoft Visual C++ 2008 SP1 redistributable.

NOTE
This can take several minutes with no indication of activity or completion.
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To remove
SMART Product Drivers

1. Open a Command Prompt window.

2. Type the following command:

msiexec /x "[Path]\SMART Product Drivers.msi" /qn

Where [Path] is the path to the SMART Product Drivers.msi file.

OR

If you want to remove the file using the product code, type:

msiexec /x [Product Code] /qn

Where [Product Code] is the product code value for the version of SMART 
Product Drivers you’re removing (see page 67).

3. Press ENTER.

Windows Installer removes SMART Product Drivers.

NOTE
This can take several minutes with no indication of activity or completion.

To remove handwriting
recognition

1. Open a Command Prompt window.

2. Type the following command:

msiexec /x "[Path]\myscript hwr ([Language]).msi" /qn 

Where:

– [Path] is the path to the handwriting recognition .msi file.

– [Language] is the name of the handwriting recognition .msi file for the installed 
language (see page 6).

OR

If you want to remove the file using the product code, type:

msiexec /x {[Product Code]} /qn 

Where [Product Code] is the product code value for the installed language 
(see page 6).

3. Press ENTER.

Windows Installer removes handwriting recognition.

NOTE
This can take several minutes with no indication of activity or completion.
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To remove the
Adobe Flash Player

ActiveX control

1. Open a Command Prompt window.

2. Type the following command:

msiexec /x "[Path]\install_flash_player_10_active_x.msi" /qn 

Where [Path] is the path to the install_flash_player_10_active_x.msi file.

OR

If you want to remove the file using the product code, type:

msiexec /x {922E8525-AC7E-4294-ACAA-43712D4423C0} /qn 

3. Press ENTER.

Windows Installer removes the Adobe Flash Player ActiveX control.

NOTE
This can take several minutes with no indication of activity or completion.
 



Chapter 4

Using SMART 
Install Manager
SMART Install Manager allows you to customize the SMART Notebook installation 
packages (also known as .msi files) by publishing .mst files. You can then install the 
.msi and .mst files using Group Policy-based software deployment or other software 
management tools.

Installing SMART Install Manager
You can install SMART Install Manager from the SMART Notebook CD.

OR

You can download and install SMART Install Manager from the SMART 
Support website.

To install the software
from the CD

1. Insert the SMART Notebook CD in your computer’s CD drive.

The SMART Notebook dialog box appears.

NOTE
If the dialog box doesn’t appear, browse to and open 
[CD Drive]\CDBrowser.exe in Windows Explorer.

2. Click Administrator Preparation and Tools, and then click 
Install SMART Install Manager.

The SMART Install Manager installation wizard appears.

3. Follow the on-screen instructions.
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To install the software
from the website

1. Go to smarttech.com/SupportNB10Win and download SMART Install Manager to 
your computer.

2. Double-click the Install Manager.exe file.

The SMART Install Manager installation wizard appears.

3. Follow the on-screen instructions.

Working with SMART Install Manager
After you install SMART Install Manager, shortcuts to the software appear on the 
desktop and in the Start menu under All Programs > SMART Technologies > 
SMART Install Manager.

With SMART Install Manager, you can do the following:

• Open an installation package.

• Save your changes to the installation package.

• Publish your changes to the installation package as an .mst file.

Opening an Installation Package
To customize an installation package, open its .msi file in SMART Install Manager by 
doing one of the following:

• Select File > Open.

• Click .

• Drag the .msi file into the SMART Install Manager window.

Alternatively, you can search for installation packages on your computer by 

clicking , or on CDs or DVDs by clicking .

TIP
All installation packages you’ve previously opened in SMART Install Manager 
appear in the Unmodified Packages tab.

After you open an installation package, a set of pages that allow you to customize the 
installation package appear in SMART Install Manager.
 

http://smarttech.com/us/Support/Browse+Support/Download+Software/Software/SMART+Notebook+collaborative+learning+software/SMART+Notebook+software/SMART+Notebook+for+Windows
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Saving Your Changes
After you customize an installation package, you can save your changes as an XML 
file by selecting File > Save As. When you next start SMART Install Manager, you can 
load the XML file by selecting File > Open, or by opening the .msi file, and then 
selecting File > Import.

TIP
All XML files you create or open in SMART Install Manager appear in the Modified 
Packages tab of the Welcome page.

Publishing Your Changes as an .mst File
The final step in using SMART Install Manager to customize an installation package is 
to publish your changes as an .mst file. Do this by selecting File > Publish, and then 
using the dialog box to define a location for and create the .mst file.

TIP
Publish the .mst file in the same network location as the .msi file.

Customizing the SMART Notebook 
Installation Package
You can customize the SMART Notebook and SMART Product Drivers installation 
packages. Open the .msi file in SMART Install Manager (see page 24), and then 
complete the procedures in the following sections.

Setting General Options
By completing the procedures in this section, you define the following options:

• The folder for the programs

• The product key

• Whether to activate the software during installation

• SMART Product Update (SPU) preferences
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To set
installation options

1. Click Installation Options.

The Installation Options page appears.

2. In the Installation directory box, type the path to your preferred folder for SMART 
Notebook.

NOTE
If you don’t specify a folder, Windows Installer installs the programs in 
%PROGRAMFILES%\SMART Technologies\SMART Notebook by default. 
SMART recommends using the default folder.

3. In the Product key box, type the 22-character product key for SMART Notebook.

NOTE
A SMART Notebook Math Tools product key activates both SMART Notebook 
and SMART Notebook Math Tools.

Configuring the SMART Notebook Installation Package
This section includes information on configuring the SMART Notebook installation 
package. 

SMART Notebook Math Tools
SMART Notebook includes a free 30-day trial of SMART Notebook Math Tools (see 
SMART Notebook Math Tools on page 1). You can enable or disable the trial software 
in SMART Install Manager.

To enable the SMART
Notebook Math Tools trial

1. Click SMART Notebook Math Tools.

The SMART Notebook Math Tools page appears.

2. Select the Install the free 30-day trial of SMART Notebook Math Tools 
check box.

SMART Product Update Options

To configure SPU 1. Click SMART Product Update (SPU) Options.

The SMART Product Update (SPU) Options page appears.

2. Select the Install SMART Product Update check box to install SPU.
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3. In the Check for updates box, type the number of days between SPU checks.

NOTE
By default, SPU checks for product updates every 30 days. You can set SPU 
to check for product updates at intervals of 1 to 60 days.

4. Select the Notify users about SMART product updates check box to notify the 
user when product updates are available.

Gallery Collections

To specify Gallery
collections and folders

For information on Gallery collections and folders, see Installing and Maintaining 
Gallery Content on page 33.

Content Folders

To specify
Team Content folders

1. Click Team Content.

The Team Content page appears.

2. In the Team Content path box, type the path to the Team Content folder.

NOTES
– A Team Content folder is a location on your network where users can 

store shared content.

– For information on creating a Team Content folder, see page 48.

To specify
My Content folders

1. Click My Content.

The My Content page appears.

2. In the My Content path box, type the path to the My Content folder.

TIP
You can use environment variables in this path. This is useful if you want to 
store content on a shared network folder so users can access their 
My Content folder from any computer on your network.

NOTE
A My Content folder is a location on the user’s computer where he or she can 
store individual content.
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Customer Experience Program

To configure the
Customer Experience

Program

1. Click Customer Experience.

The Customer Experience page appears.

2. Click Allow users to participate in the Customer Experience Program to allow 
the user to enable or disable the Customer Experience Program.

OR

Click Enable the Customer Experience Program on all computers to enable 
the Customer Experience Program for the user automatically.

Print Capture Driver

To configure the
Print Capture Driver

1. Click Print Capture.

The Print Capture page appears.

2. Select the Install print capture driver check box to include the Print Capture 
Driver in the installation.

NOTE
The Print Capture Driver is a printer driver that allows users to import content 
from other programs into SMART Notebook.

Notebook Plugin

To install Notebook Plugin 1. Click Optional Settings. 

The Optional Settings page appears.

2. Select the Install Notebook Plugin IE Helper Object check box to include the 
Notebook Plugin in the installation.

NOTE
If you have a security policy restricting the installation of any Internet 
Explorer® ActiveX plug-ins (32-bit operating systems), you need to include 
NBPLUGIN_INSTALLED=0 or the installation may not succeed.
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SMART Document Camera Drivers

To install the SMART
Document Camera drivers

1. Click Optional Settings. 

The Optional Settings page appears.

2. Select the Install SMART Document Camera drivers check box to include the 
Document Camera drivers in the installation.

NOTE
Disable the registration of SMART Document Camera drivers if they conflict 
with existing third-party drivers on the computer.

Customizing the SMART Product Drivers Installation 
Package
Open the SMART Product Drivers.msi file in SMART Install Manager (see page 24), 
and then complete the procedures in the following sections.

To set
installation options

1. Click Installation Options.

The Installation Options page appears.

2. In the Installation directory box, type the path to your preferred folder for SMART 
Product Drivers.

NOTE
If you don’t specify a folder, Windows Installer installs the program in 
%PROGRAMFILES%\SMART Technologies\SMART Product Drivers by 
default. SMART recommends using the default folder.

SMART Product Update Options

To configure SPU 1. Click SMART Product Update (SPU) Options.

The SMART Product Update (SPU) Options page appears.

2. Select the Install SMART Product Update check box to install SPU.

3. In the Check for updates box, type the number of days between SPU checks.

NOTE
By default, SPU checks for product updates every 30 days. You can set SPU 
to check for product updates at intervals of 1 to 60 days.
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4. Select the Notify users about SMART product updates check box to notify the 
user when product updates are available.

Driver Installation Options

To set driver installation
options

1. Click Driver Installation Options. 

The Driver Installation Options page appears.

2. Select the Install SMART Document Camera drivers check box to include the 
Document Camera drivers in the installation.

NOTE
Disable the registration of SMART Document Camera drivers if they conflict 
with existing third-party drivers on the computer.

3. Select the Unsigned drivers check box to include the unsigned drivers in the 
installation.

NOTE
If you enable the registration of unsigned third-party drivers, the installation 
process may ask users if they trust the makers of the drivers during 
installation. This can cause issues if you’re deploying the installation in Silent 
mode. Therefore, it is best to disable the registration of third-party drivers if 
you’re deploying the installation in Silent mode.

Post-Installation Options

To configure
post-installation options

1. Click SMART Tools.

The SMART Tools page appears.

2. Select the Start SMART Tools at logon check box to start SMART Tools each 
time the user logs on.

3. Click Tablet PC Support.

The Table PC Support page appears.
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4. Select the Enable Tablet PC Support check box to use Tablet PC functionality 
with the SMART Board interactive whiteboard without having to connect a 
Tablet PC.

NOTES
– This check box is applicable only to Windows Vista and Windows 7 

operating systems. It has no effect on other operating systems.

– If you don’t select this check box, users won’t have touch support at the 
Windows logon screen.

5. Click SNMP Agent.

The SNMP Agent page appears.

6. Select the Start Simple Network Management Protocol (SNMP) Agent 
check box to enable remote monitoring and control of your SMART products and 
projectors from a shared location using SMART SNMP Agent.

NOTE
For more information on SMART SNMP Agent, see the SMART SNMP Agent 
Administrator’s Guide (smarttech.com/kb/128702).

Deploying the Installation Packages
After you publish .mst files for the SMART Notebook installation packages, you can 
install these installation packages using Group Policy-based software deployment or 
other software management tools.

NOTE
These procedures can vary depending on your version of Windows operating 
system and your system preferences.

To deploy an
installation package using

Group Policy

1. Copy the .msi file and the .mst file you published using SMART Install Manager 
(see page 25) to \\[Domain Controller]\NETLOGON, where [Domain Controller] 
is your network’s domain controller.

2. Open Control Panel, double-click Administrative Tools, and then 
double-click Active Directory Users and Computers.

The Active Directory Users and Computers window appears.

3. Right-click your network’s domain, and then select Properties.

The Properties dialog box appears.
 

http://downloads.smarttech.com/media/sitecore/en/support/product/installmanager/guides/snmpagentadminguidev04sept08.pdf
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4. Click the Group Policy tab, and then click Edit.

The Group Policy Object Editor dialog box appears.

5. Browse to and open Computer Configuration\Software Settings.

6. Right-click Software Installation, select New > Package, and then select the 
.msi file from step 1.

7. In the Deploy Software section, click Advanced, and then click OK.

8. Click the Modifications tab, click Add, and then select the .mst file from step 1.

9. Click OK to apply the .mst file to the .msi file.

10. Close all open windows and dialog boxes.

The next time each computer on the domain starts, it automatically installs the 
software in Silent mode with the customizations defined in the .mst file.

To remove a deployed
installation package

1. Open Control Panel.

2. Double-click Administrative Tools.

3. Double-click Active Directory Users and Computers.

The Active Directory Users and Computers window appears.

4. Right-click your network’s domain, and then select Properties.

The Properties dialog box appears.

5. Click the Group Policy tab, and then click Edit.

The Group Policy Object Editor dialog box appears.

6. Browse to and open Computer Configuration\Software Settings\
Software Installation.

7. Right-click the software you want to remove, and then select All Tasks > 
Remove.

8. Select Immediately uninstall the software from users and computers, and 
then click OK.

The next time each computer on the domain starts, it automatically removes 
the software.
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Installing and 
Maintaining Gallery 
Content
This chapter explains how to install and configure Gallery content using SMART Install 
Manager (page 34) or the command line interface (page 37), and how to modify it 
using Gallery Setup (page 40).

SMART Notebook’s Gallery content includes the following:

• Gallery Essentials, which is a collection of educational photos and other images, 
audio files, and Adobe Flash Player compatible files

• Lesson Activity Toolkit, which contains objects you can use to create your own 
lesson activities

Gallery content is accessible from the Gallery tab in SMART Notebook:
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Installing and Configuring Gallery Content 
Using SMART Install Manager
You can install and configure Gallery content using SMART Install Manager. If you 
prefer to use the command line interface, see Installing and Configuring Gallery 
Content with the Command Line Interface on page 37.

You can install and configure Gallery content in either of the following ways:

• On each computer (this page).

• In a network location you can configure SMART Notebook to refer to (page 37). 

TIP
Sharing the Gallery is ideal for environments where hard disk space on user 
computers is limited. 

The following procedures refer to installing the content on each computer.

Installing Gallery Content On Each Computer
Before you can install the Gallery content on each computer, download it to a folder on 
your network.

IMPORTANT
If you download Gallery content to a folder on your network, ensure the folder is 
accessible to all users who need to access it. 

OR

Download the content from the SMART website to each computer during the SMART 
Notebook installation.

NOTE
Because of the size of the Gallery download, SMART doesn’t recommend this 
method unless you’re only installing the Gallery on one or two computers.

To download
Gallery content

1. Open the SMART Notebook installation package in SMART Install Manager 
(see page 24).

2. Click Gallery Content.

The Gallery Content page appears.

3. Click Install the Gallery on each computer.
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4. Delete the path in the Source location box, if a path appears.

5. Click Download, and then specify a network folder accessible to all users who 
need to access the Gallery.

The Gallery content is downloaded to the specified folder, where the installer will 
access it during the SMART Notebook installation to place the content on each 
computer.

Configuring Gallery Content on Each Computer
Once you’ve downloaded the Gallery content to a network folder, complete the 
procedure in this section to configure the SMART Notebook installation to refer to the 
network location.

To configure
Gallery content

on each computer

1. Open the SMART Notebook installation package in SMART Install Manager 
(see page 24).

2. Click Gallery Content.

The Gallery Content page appears.

3. Click Install the Gallery on each computer.

4. In the Source location box, type the path of the folder on your network that 
contains the Gallery content (if you downloaded Gallery collections to your 
school’s network).

NOTE
The Source location box auto-populates with the path you specified in the 
Installing Gallery Content On Each Computer procedure on page 34.

5. Optionally, if you don’t want to use the default folder, type the path of the location 
on each computer where you want to install the Gallery collections in the 
Destination box.

NOTE
The default folder location is %ALLUSERSPROFILE%\Application 
Data\SMART Technologies.

6. Clear the check boxes of the Gallery collections you don’t want to install.

7. Publish your changes as an .mst file (see page 25), and then deploy the .msi and 
.mst files (see page 31).

The installed software will access the Gallery content from the network location 
you specified in the previous procedure.
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Installing Gallery Content in a Network Location
Downloading and installing Gallery content in a shared location on your school’s 
network allows all users access without having to save the files locally on their 
computers.

To place and use Gallery content in a shared location on your school’s network, you 
must first download and install the content in that location by performing the procedure 
in this section.

To download and install
Gallery content in a

shared location

1. Open the SMART Notebook installation package in SMART Install Manager 
(see page 24).

2. Click Gallery Content.

The Gallery Content page appears.

3. Click Share Gallery content with all computers from a common network 
location.

4. If you want to download the Gallery Essentials collection, click Install beside 
Essentials for Educators, specify a network location accessible to all users, and 
then follow the on-screen instructions.

IMPORTANT
Use the Universal Naming Convention (UNC) for the path in this and the 
following step.

NOTE
You can select which Gallery categories you want to install during the 
Gallery Setup. See Using Gallery Setup on page 40 for more information.

5. If you want to download the Lesson Activity Toolkit collection, click Install beside 
Lesson Activity Toolkit, specify a network location accessible to all users, and then 
follow the on-screen instructions.

Configuring Gallery Content in a Network Location
Once you’ve downloaded the Gallery content to a network folder, complete the 
procedure in this section to configure the SMART Notebook installation to refer to the 
network location.

To configure
Gallery content using

SMART Install Manager

1. Open the SMART Notebook installation package in SMART Install Manager 
(see page 24).

2. Click Gallery Content.

The Gallery Content page appears.
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3. Click Share Gallery content with all computers from a common network 
location.

4. In the Gallery location box, type the path of the folder on your school’s network 
that contains the Gallery content.

NOTE
The Gallery location box auto-populates with the folder location you specified 
in Installing Gallery Content in a Network Location on page 36.

5. Publish your changes as an .mst file (see page 25), and then deploy the .msi and 
.mst files (see page 31).

The installed software will access the Gallery content from the network location 
you specified in the previous procedure.

Installing and Configuring Gallery Content 
with the Command Line Interface
You can install and configure Gallery content using the command line interface. If you 
prefer to use SMART Install Manager, see Installing and Configuring Gallery Content 
Using SMART Install Manager on page 34.

You can install Gallery content in either of the following ways:

• On each computer (this page)

• In a network location you can configure SMART Notebook to refer to (page 39). 

TIP
Sharing the Gallery is ideal for environments where hard disk space on user 
computers is limited. 

Installing Gallery Content on Each Computer
Include the following properties in your command to install the Gallery on each 
computer. See Using the Command Line Interface on page 7 for more information.

• CONTENT_SOURCE_PATH 

Value Enter this value to:

[Path] Specify the path to the folder on your school’s network that 
contains the Gallery Essentials and Lesson Activity Toolkit 
folders (if you downloaded the Gallery Essentials and 
Lesson Activity Toolkit collections).
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• CONTENT_TARGET_PATH 

• FULL_GALLERY

• LAT_CONTENT 

Value Enter this value to:

[Path] Specify the path to the folder where you want to install the 
Gallery content (if you don’t want to use the default folder 
%ALLUSERSPROFILE%\Application Data\
SMART Technologies).

Value Enter this value to:

1 Install the full Gallery Essentials collection.

If you want to install certain categories only, include the 
following properties instead of FULL_GALLERY:

• ADMIN_CONTENT=1 (Administration and Evaluation)

• ARTS_CONTENT=1 (Arts)

• ENGLISH_CONTENT=1 (English and Language Arts)

• GEOGRAPHY_CONTENT=1 (Geography)

• HISTORY_CONTENT=1 (History)

• MATH_CONTENT=1 (Mathematics)

• PEOPLE_CONTENT=1 (People and Culture)

• SCIENCE_CONTENT=1 (Science and Technology)

• SPECIAL_CONTENT=1 (Special Needs)

• SPORTS_CONTENT=1 (Sports and Recreation)

Value Enter this value to:

1 Install the Lesson Activity Toolkit collection.
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• TEAM_CONTENT_PATH

• MY_CONTENT

Configuring Gallery Content in a Shared Location
Include the following properties in your command to install the Gallery in a shared 
location. See Using the Command Line Interface on page 7 for more information.

IMPORTANT
You must refer to an existing folder to use these properties. See Using Gallery 
Setup on page 40 for more information.

• NETWORK_CONTENT 

NOTE
Because you include this property with a value of 1, Windows Installer ignores 
the CONTENT_SOURCE_PATH, FULL_GALLERY and *_CONTENT 
properties.

Value Enter this value to:

[Path] Specify the path to the folder where you want to save team 
content. 

IMPORTANT
You must specify a path to an existing folder in this 
property. See Changing Gallery Content Locations on 
page 47 for information on creating or changing the 
location of Team Content folders.

Value Enter this value to:

[Path] Specify the path to the user’s folder where you want the My 
Content folder to appear. 

TIP
You can use environment variables in this path. This is 
useful if you want to store content on a shared network 
folder so users can access their My Content folder from 
any computer on your network.

Value Enter this value to:

1 Refer to Gallery content in a shared location specified in the 
CONTENT_TARGET_PATH property.
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• CONTENT_TARGET_PATH 

Using Gallery Setup
After you install SMART Notebook, you can modify Gallery content using Gallery 
Setup. This program is available under %PROGRAMFILES%\Common Files\
SMART Technologies\SMART Product Update, and you can run it from a graphical 
user interface or the command line.

To run Gallery Setup from
a graphical user interface

1. In Windows Explorer, browse to %PROGRAMFILES%\Common Files\
SMART Technologies\SMART Product Update.

2. Double-click Gallery Setup.exe.

The Select a Gallery dialog box appears.

3. Select the Gallery collection you want to modify, and then click OK.

Gallery Setup starts.

4. On the Content tab, select the check boxes of the categories you want to include 
and clear the check boxes of the categories you don’t want to include.

5. On the Languages tab, select the check boxes of the language packs you want to 
include and clear the check boxes of the language packs you don’t want 
to include.

TIP
To see the language pack names in English, clear the Show native names 
check box.

6. In the Installation folder for Gallery content box, type the path to the folder where 
you want to store the Gallery collection.

7. Click OK.

Gallery Setup updates the selected Gallery collection.

8. Click Finish.

Value Enter this value to:

[String] Specify the path to the folder on your school’s network that 
contains the Gallery Essentials and Lesson Activity Toolkit 
folders.
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To run Gallery Setup from
the command line

1. Open a Command Prompt window.

2. Type the following command:

"[Path]\Gallery Setup.exe" [Command] [Flags] [Parameters] 
/qn

Where:

– [Path] is the path to the Gallery Setup.exe file.

NOTE
The default path is %PROGRAMFILES%\Common Files\
SMART Technologies\SMART Product Update.

– [Command] is a command (see page 42).

– [Flags] is one or more optional flags for the command (see page 43).

– [Parameters] is one or more parameters for the command (see page 44).

NOTES
– For example commands, see page 45.

– Gallery Setup doesn’t support Windows Installer options.

3. Press ENTER.

Gallery Setup updates the selected Gallery collection.
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Commands
The following table defines available commands for Gallery Setup.

Command Purpose Notes

--downloadall Downloads the entire Gallery 
collection to a source folder.

--downloadsome Downloads specific categories 
of the Gallery collection to a 
source folder.

Specify which categories you 
want to download using the --c 
parameter.

--installall Installs the entire Gallery 
collection from the source 
folder to the destination folder.

• If you omit the --source 
parameter, Gallery Setup 
doesn’t use a default path 
unless you provide the 
--allowdownload flag.

• If you omit the --destination 
parameter, Gallery Setup 
uses the default path defined 
in the Gallery collection’s 
configuration.

--installsome Installs specific categories of 
the Gallery collection from the 
source folder to the destination 
folder.

• If you omit the --source 
parameter, Gallery Setup 
doesn’t use a default path 
unless you provide the 
--allowdownload flag.

• If you omit the --destination 
parameter, Gallery Setup 
uses the default path defined 
in the Gallery collection’s 
configuration.

• Specify which categories 
you want to download using 
the --c parameter.

--teamcontent Registers additional Team 
Content at the folder specified 
by the --destination 
parameter.

You must enter an existing 
Gallery destination.

--mycontent Sets the default My Content 
path to the folder specified by 
the --destination parameter.
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Flags
The following table defines available flags for Gallery Setup.

--repair Attempts to detect and 
optionally remove corrupted 
galleries. 

Include the --allowcleanup 
parameter to delete corrupt 
galleries.

--uninstall Removes the installed Gallery 
collection.

--register Defines the location of Gallery 
content.

Use this command with the 
--destination and 
--configuration parameters, or 
with the --guid parameter.

Flag Purpose Notes

--remote Prevent Gallery Setup from 
registering itself with 
SMART Notebook.

This disables the Check for 
Updates feature and prevents 
users from updating the 
content.

--verbose Output progress of operations 
to standard output when 
working in command line 
mode.

--overrideproxy Set Gallery Setup to ignore 
default (system-wide or 
previously set) proxy settings 
where applicable, and use a 
proxy specified by the --proxy 
parameter (server:port 
format), using a user name and 
password provided by the 
--username and --password 
parameters.

You can set a user name and 
password without 
--overrideproxy, and still use it 
for authentication with the 
default proxy.

--allowdownload Download the Gallery 
collection from the default URL 
specified in the configuration.

Use this flag with the 
--installall or --installsome 
parameters when you omit the 
--source parameter.

--forcedest Share Gallery content across 
users.

Command Purpose Notes
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Parameters
The following table defines available parameters for Gallery Setup.

Parameter Value Purpose Notes

--source [Path] Defines the path to a local or 
network folder where the 
Gallery content is stored before 
installation.

If you omit this parameter, the 
installation program uses the 
default URL from the Gallery 
configuration, as specified by 
the --guid or --configuration 
parameters.

--destination [Path] Defines the path to a local or 
network folder where Gallery 
Setup installs the Gallery 
content.

If you omit this parameter, 
Gallery Setup uses this default 
path found in the computer’s 
registry: 
%ALLUSERPROFILES%\
Application Data\
SMART Technologies\
Gallery Essentials.

--configuration [Path] Defines the full path to a 
.gallerycollection file, including 
the file name.

If you omit this parameter, you 
must provide the --guid 
parameter to specify a known 
Gallery collection.

--proxy [Server:
Port]

Specifies the proxy used by 
Gallery Setup when you 
include the --overrideproxy 
flag.

--guid [Identifier] Specifies a known Gallery 
collection to work with.

A Gallery collection is known if 
Gallery Setup has already 
opened its .gallerycollection 
file. In this situation, use this 
parameter instead of the 
--configuration parameter.
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Examples

Downloading a Gallery Collection
Use the following command to download the Gallery collection source files to a 
destination folder:

"[Path]\Gallery Setup.exe" --downloadall --destination 
"[Path]" --configuration "[Path]" /qn

--c [Alias] Downloads or installs the 
category of the Gallery 
collection identified by [Alias].

Use this parameter with the 
--downloadsome and 
--installsome commands.

You can include several --c 
parameters in a single 
command. Valid [Alias] values 
for the Gallery Essentials 
collection are:

• administration
• arts
• english
• geography
• history
• math
• people
• tech
• needs
• sports

--ui N/A Specifies the user interface 
level.

Use this parameter to show a 
progress indicator and error 
messages. If you don’t include 
this parameter, Gallery Setup 
works silently without a user 
interface.

• Use --register with the 
--downloadall or 
--downloadsome 
parameters to display the full 
user interface.

• Use --register with the 
--installall or --installsome 
parameters to display a 
minimal user interface.

Parameter Value Purpose Notes
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Downloading Certain Categories of a Gallery Collection
Use the following command to download only certain categories of Gallery collection 
source files to a destination folder:

"[Path]\Gallery Setup.exe" --downloadsome --destination 
"[Path]" --configuration "[Path]" --c "[Alias 1]" 
--c "[Alias 2]" /qn

Installing a Gallery Collection
Use the following command to download and install a Gallery collection to a 
destination folder:

"[Path]\Gallery Setup.exe" --installall --allowdownload 
--destination "[Path]" --configuration "[Path]" /qn

Installing Certain Categories of a Gallery Collection
Use the following command to download and install certain categories of a Gallery 
collection to a specific destination folder:

"[Path]\Gallery Setup.exe" --installsome --remote 
--source "[Path]" --allowdownload --destination "[Path]" 
--configuration "[Path]" --c "[Alias 1]" --c "[Alias 2]" /qn

Registering Installed Gallery Collections with SMART Notebook
If you’ve installed Gallery collections to a network location, use the following 
command to register the Gallery content with SMART Notebook on each user’s 
computer:

"[Path]\Gallery Setup.exe" --register --remote --forcedest 
--destination "[Path]" --configuration "[Path]" /qn

Removing a Gallery Collection
Use the following command to remove the Gallery Essentials collection:

"[Path]\Gallery Setup.exe" --uninstall 
--guid gallery.smarttech.com /qn

TIP
To automate the removal of a Gallery collection, you can use the command in a 
batch file as a startup script.
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Changing Gallery Content Locations
After you install SMART Notebook, you can do the following:

• Change the location of the My Content folder.

• Create or connect to a Team Content folder.

• Connect to an RSS feed.

Starting SMART Notebook in Administration Mode
Before you can maintain content folders in SMART Notebook, you must start the 
programs in Administration mode.

To start
SMART Notebook

in Administration mode

1. Open a Command Prompt window.

2. Type the following command:

"[Path]\Notebook.exe" /admin /qn

Where [Path] is the path to the SMART Notebook software program folder, 

NOTE
The default path is %PROGRAMFILES%\SMART Technologies\.

3. Press ENTER.

SMART Notebook software starts in Administration mode.

Changing the Location of the My Content Folder
The My Content folder is a location where users can store content for their 
individual use.

You can specify the location of the My Content folder during installation. If you don’t 
specify a location, the default location is %APPDATA%\SMART Technologies\
Gallery\My Content.

You can change the location of the My Content folder after installation.

To change the
location of the

My Content folder

1. Start SMART Notebook in Administration mode (see page 47).

2. Open the Gallery tab.
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3. Click Show additional Gallery actions , and then select 
Administration: Content Locations.

The Administration: Content Locations dialog box appears.

4. Click Browse.

The Browse For Folder dialog box appears.

5. Browse to and select the new My Content folder, and then click OK.

6. Click Close.

7. Close SMART Notebook.

Creating or Connecting to Team Content Folders
All SMART Notebook users can create new content and save it in their My Content 
folders. To allow users to share content, you must create or connect to a 
Team Content folder.

TIP
If you create a Team Content folder on a computer’s hard disk, the folder is 
available only to users of that computer. However, if you create a Team Content 
folder on a server, the folder is available to all users on the network with read and 
write access to the folder.

To create a new
Team Content folder

1. Start SMART Notebook in Administration mode (see page 47).

2. Open the Gallery tab.

3. Click Show additional Gallery actions , and then select 
Administration: Content Locations.

The Administration: Content Locations dialog box appears.

4. Click Create New.

The Browse For Folder dialog box appears.

5. Browse to and select the new Team Content folder, and then click OK.

NOTE
SMART Notebook adds a imsmanifest.xml file to the Team Content folder 
after you click OK. This file identifies the folder as a Team Content folder.
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6. Click Close. .

7. Close SMART Notebook.

To connect to an existing
Team Content folder

1. Start SMART Notebook in Administration mode (see page 47).

2. Open the Gallery tab.

3. Click Show additional Gallery actions , and then select 
Administration: Content Locations.

The Administration: Content Locations dialog box appears.

4. Click Add Existing.

The Browse For Folder dialog box appears.

5. Browse to and select the Team Content folder, and then click OK.

6. Click Close.

7. Close SMART Notebook.

To disconnect a
Team Content folder

1. Start SMART Notebook in Administration mode (see page 47).

2. Open the Gallery tab.

3. Click Show additional Gallery actions , and then select 
Administration: Content Locations.

The Administration: Content Locations dialog box appears.

4. Select the folder in the Team Content list, and then click Remove.

IMPORTANT
If you installed the Gallery Essentials and Lesson Activity Toolkit collections, 
folders for those collections appear in the Team Content list. Do not remove 
these folders from the list, or users will not be able to access these 
collections.

5. Click Close.

6. Close SMART Notebook.
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Connecting to an RSS Feed
RSS is a format for delivering regularly changing web content. Many news-related 
websites, blogs and other publishers broadcast their content as RSS feeds. You can 
connect to a public or private RSS feed to send information to SMART Notebook 
users through the Gallery tab.

To connect to an RSS feed 1. Start SMART Notebook in Administration mode (see page 47).

2. Open the Gallery tab.

3. Click Show additional Gallery actions , and then select 
Administration: Content Locations.

The Administration: Content Locations dialog box appears.

4. Type the URL of the RSS feed in the Online Resources box.

5. Click Close.

6. Close SMART Notebook.
 



Chapter 6

Updating SMART 
Notebook 
SMART offers software updates for licensed users. If you’ve installed SMART 
software, check smarttech.com/support for recent updates that add new features and 
resolve issues.

When SMART software updates are available, SMART provides the updates in a 
Windows Installer updated installation package (an .msi file). Some updates also 
include a Windows Installer patch (an .msp file).

Using a Windows Installer Update 
Installation Package
When you download the most recent update for SMART Notebook 10.6 software, the 
installation package includes an .msi file.

The SMART website identifies an .msi installation package as either a major or a 
minor update.

Major Update Installation Package
When the SMART website identifies an .msi installation package as a major update, 
follow the instructions below.

To run a major software
update using an .msi file

1. Open a Command Prompt window.

2. Type the following command:

msiexec /i "[Path]\[File].msi" /qn

Where:

– [Path] is the path to the .msi file.

– [File] is the name of the .msi file.
 

http://www2.smarttech.com/st/en-US/Support/Downloads/default.htm
http://www2.smarttech.com/st/en-US/Support/Downloads/default.htm
http://www.smarttech.com/support
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NOTE
You can copy the .msi file to any accessible server and run the command 
referencing that location.

IMPORTANT
– Do not use any other options.

– You can not use a command line to remove an update. To remove an 
update, you must remove the full version of SMART Board software or 
SMART Notebook software using Windows Control Panel or a command 
line (see Removing Previous Versions of SMART Notebook on page 61), 
and then reinstall the software.

3. Press ENTER.

Minor update installation package
When the SMART website identifies an .msi installation package as a minor update, 
follow the instructions below.

To run a minor software
update using an .msi file

1. Open a Command Prompt window.

2. Type the following command:

msiexec /i "[Path]\[File].msi" /qn
REINSTALLMODE=vomus REINSTALL=ALL /qn

Where:

– [Path] is the path to the .msi file.

– [File] is the name of the .msi file.

NOTE
You can copy the .msi file to any accessible server and run the command 
referencing that location.

IMPORTANT
– If you omit the REINSTALLMODE=vomus and REINSTALL=ALL 

properties in a minor update, the update does not succeed.

– Do not use any other options.

– You can not use a command line to remove an update. To remove an 
update, you must remove the full version of SMART Board software or 
SMART Notebook software using Windows Control Panel or a command 
line (see Removing Previous Versions of SMART Notebook on page 61), 
and then reinstall the software.
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3. Press ENTER.

Using a Windows Installer Patch
When you download the most recent patch for SMART Notebook 10.6 software, the 
installation package includes an .msp file.

The .msp file contains all of the information that Windows Installer requires to install 
the updated software.

NOTE
You can’t update an earlier version of SMART Board software or SMART 
Notebook software to the current version. You can apply updates only to the 
current version of SMART Notebook software.

To run a software update
using an .msp file

1. Open a Command Prompt window.

2. Type the following command:

msiexec /p "[Path]\[File].msp" /qn
REINSTALLMODE=vomus REINSTALL=ALL /qn

Where:

– [Path] is the path to the .msi file.

– [File] is the name of the .msi file.

NOTE
You can copy the .msp file to any accessible server and run the command 
referencing that location.

IMPORTANT
– If you omit the REINSTALLMODE=vomus and REINSTALL=ALL 

properties, the installation does not succeed.

– Do not use any other options.

– You ca not use a command line to remove an update. To remove an 
update, you must remove the full version of SMART Board software or 
SMART Notebook software using Windows Control Panel or a command 
line (see Removing Previous Versions of SMART Notebook on page 61), 
and then reinstall the software.

3. Press ENTER.
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Appendix A

Language Setup
SMART Notebook supports the following languages:

SMART Notebook displays the language appropriate to the computer’s location. If the 
computer’s local language isn’t supported, the software displays English (U.S.) by 
default.

You can change the language SMART Notebook displays by following the procedure 
on the next page.

• Albanian

• Arabic

• Basque

• Catalan

• Chinese (simplified)

• Chinese (traditional)

• Croatian

• Czech

• Danish

• Dutch

• English (U.S.)

• English (UK)

• Estonian

• Farsi

• Finnish

• French

• Galician

• German

• Greek

• Hebrew

• Hindi

• Hungarian

• Icelandic

• Irish Gaelic

• Italian

• Japanese

• Kazakh

• Korean

• Latvia

• Lithuanian

• Macedonian

• Malay

• Maori

• Norwegian (Bokmal)

• Polish

• Portuguese (Brazil)

• Portuguese (Portugal)

• Romanian

• Russian

• Scots Gaelic

• Serbian

• Slovak

• Slovenian

• Spanish (Spain)

• Spanish (Mexico)

• Swahili

• Swedish

• Turkish

• Ukrainian

• Valencian

• Welsh
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To change
SMART Notebook’s

language

1. Select View > Language Setup.

The Language Setup dialog box appears.

2. Select SMART Notebook in the first drop-down list.

3. Click Update Languages, and then follow the on-screen instructions to download 
the desired language.

4. Select the language in the second drop-down list.

5. Select the check box to the use this language for handwriting recognition.

OR

Select the language you want to use for handwriting recognition in the third 
drop-down list.

IMPORTANT
You need to install the handwriting recognition language packs for the 
language you want to use with handwriting recognition. See Handwriting 
Recognition Language Installation Packages on page 6.

6. Click OK.
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Mass Activation
If you install SMART Notebook software on multiple computers or use protection 
software, SMART Notebook software might not activate completely. This appendix 
presents guidelines for properly activating SMART Notebook software when imaging a 
computer or using protection software on your network.

Imaging a Computer
For SMART Notebook software to activate properly, each computer you install it on 
must have a unique installation ID. If you use a computer image or clone a hard drive 
to set up multiple computers, they all have the same installation ID as the original 
computer.

Run the activation wizard while connected to the network or use one of the command 
lines below to complete the activation on each computer.

Protecting Software for Computer 
Configurations
If you use system recovery or protection software, activate SMART Notebook 
software before you lock or freeze the computer for your students, teachers and other 
users. If you didn’t activate the software, run the activation wizard while connected to 
the network or use one of the command lines below in your next maintenance window.
 



58 | APPENDIX B  –  MASS ACTIVATION
Command Line Activation
Use your choice of server-based management software to push one of the following 
command lines on your network and globally activate SMART Notebook software.

NOTES
• The command line to activate SMART Notebook software varies depending 

on your version of the software and your operating system.

• In the following examples, NB-XXXXX-XXXXX-XXXXX-XXXXX is your 
product key.

SMART Notebook 10 SP3 or Later
Activate SMART Notebook using the administrative method by running the following 
command:

"C:\Program Files\Common Files\SMART Technologies\
SMART Product Update\activationwizard.exe" --puid 
clash_notebook --m=4 --v=1 --a --pk NB-XXXXX-XXXXX-XXXXX-XXXXX 
/qn

SMART Notebook 10 SP2 or Earlier
Activate SMART Notebook using the administrative method by running the following 
command:

"C:\Program Files\Common Files\SMART Technologies\
SMART Product Update\activationwizard.exe" --puid 
clash_notebook --m=4 --a --pk NB-XXXXX-XXXXX-XXXXX-XXXXX /qn
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Activation Flags
The following flags are available if you activate SMART Notebook software through 
the command line.

NOTE
These flags are available only for activating SMART Notebook 10 SP3 or later.

Flag Include this flag to:

--a Activate SMART Notebook immediately.

--v=1 Activate SMART Notebook 10 SP3 or later.

NOTE
Omit this flag when activating SMART Notebook 10 SP2 
or earlier.

--pk Enter your product key. You can enter several product keys in 
one command.

--puid Enter your product identifier. The product identifier for SMART 
Notebook is clash_notebook.

--m=<value> Run the activation wizard.

• Where <value>=4: the activation wizard runs in unattended 
mode.

• Where <value>=6: the activation wizard runs in UI (user 
interface) mode.

--monitor=
<number> 

Specify the monitor to display the activation wizard.

--proxy=
<host:port> 

Specify the proxy host and port number to use for activation.

--proxyuser=
<user> 

Specify the proxy user name to use for activation.

--proxypassword=
<password> 

Specify the proxy password to use for activation.

--locale=<code> Display the activation wizard UI in a specific language, where 
<code> is your language code.
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Appendix C

Removing Previous 
Versions of 
SMART Notebook
If you have version 9.0 or earlier of SMART Board software or SMART Notebook 
software on your computers, SMART recommends that you remove it before installing 
a new version.

When you remove a previous version of SMART Board software or SMART Notebook 
software, the uninstall process can leave behind registry entries, preventing you from 
installing or updating SMART Notebook.

CAUTION
Use caution when you open the Windows registry editor. If you incorrectly modify 
the Windows registry, you can damage your computer’s operating system. Back 
up your registry before performing the following procedures.

If you’re still having difficulties with remaining registry files, ensure that you have 
administrator rights and manually search the registry for SMART Board software, 
SMART Product Drivers or SMART Notebook software files.

CAUTION
Do not remove files for other SMART products you want to retain. If you are 
unsure, contact SMART Technologies.

To manually clean
the registry

1. Click Start > Run.

The Run dialog box appears.

2. Type regedit, and click OK.

The Registry Editor window appears.
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3. In the Registry Editor window, look for SMART files in the following locations, and 
delete them:

HKEY_CURRENT_USER\Software\SMART Technologies Inc.
HKEY_LOCAL_MACHINE\Software\SMART Technologies Inc.
HKEY_CURRENT_USER\Software\SMART Technologies
HKEY_LOCAL_MACHINE\Software\SMART Technologies

4. Close the Registry Editor window.

5. Restart your computer.

Removing SMART Board Software 7.x
SMART uses the InstallShield installation utility to install SMART Board software 7.x. 
To remove this version of software silently, you must create a setup.iss file, and then 
remove SMART Board software from all computers using the .iss file you create.

NOTE
You need to create a setup.iss file only once. You can use this setup.iss file to 
remove the same version of SMART Board software from other computers on 
your network.

Before you can perform the following procedures, you must obtain the GUID 
(Globally Unique Identifier) for your version of SMART Board software. You can find 
your GUID in the following table:

NOTE
Include the braces—“{” and “}”—when entering a GUID in the following 
commands.

Software Version GUID

7.0 {72226969-B20E-439E-B0A1-FD1EE5403CCF}

7.1 {93458E57-1D12-4F01-980D-62D5430048D0}

7.1.1 {14AE43DA-37FE-4B73-99C0-D02E01B48837}

7.1.2 {28E27E54-92A5-4717-A4E5-837D7E894AB4}

7.1.3 {FF332803-8B46-4392-A2F4-8790735F7B26}
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To create the .iss
silent removal file

1. Check the version of SMART Board software installed on your computer. Refer to 
the previous table to identify the GUID you must use in the following commands.

2. Open a Command Prompt window.

3. Type the following command:

RunDll32 
C:\PROGRA~1\COMMON~1\INSTAL~1\PROFES~1\RunTime\0701\Intel32
\Ctor.dll,LaunchSetup "C:\Program Files\
InstallShield Installation Information\GUID\setup.exe"
/r -l0x9 --AddRemove /qn

This command removes SMART Board software and creates a setup.iss file in 
the root Windows folder. 

4. Press ENTER. 

5. Move the setup.iss file to a server where all computers can access it.

To remove SMART Board
software 7.x

1. Open a Command Prompt window.

2. Type the following command (including quotation marks):

RunDll32 
C:\PROGRA~1\COMMON~1\INSTAL~1\PROFES~1\RunTime\0701
\Intel32\Ctor.dll,LaunchSetup "C:\Program Files\
InstallShield Installation Information\GUID\setup.exe" 
/s -l0x9 --AddRemove /f1"path to the setup.iss file\
setup.iss" /f2"destination path for the uninstall log 
file\setup.log" /qn

NOTE
To automate the removal of SMART Board software, you can apply the 
command in a batch file as a startup script.

3. Press ENTER.
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Removing SMART Board Software 8.x
SMART uses the InstallShield installation utility to install SMART Board software 
version 8.x. To remove this version of software silently, you must create a setup.iss 
file, and then remove SMART Board software from all computers using the .iss file 
you create. 

NOTE
You only need to create a setup.iss file once. You can use this setup.iss file to 
remove the same version of SMART Board software from other computers on 
your network. 

Before you perform the following procedures, obtain the product code for your version 
of SMART Board software from the following table:

NOTE
Include the braces—“{” and “}”—when entering a Product Code value in the 
following commands.

To create the .iss
silent removal file

1. Check the version of SMART Board software installed on your computer. Refer to 
the table above to identify the relevant Product Code value.

2. Open a Command Prompt window.

3. Type the following command (including quotation marks), and then press ENTER:

"C:\Program Files\Common Files\InstallShield\Driver\8\
Intel 32\IDriver.exe" /MProductCode /l1033 /r 
/z-AddRemove --RemoveReg /qn

This command removes SMART Board software and creates a setup.iss file in 
the root Windows folder. 

4. Move the setup.iss file to a server where all computers can access it.

Software Version Product Code Value 

8.0.0.52 {7823065C-AA64-425D-A9A3-18BF7B99E944}

8.0.1 {F414173A-7BE1-46C6-811A-51277A4D9E7B}

8.1.0 {155FBC4E-CF09-4698-961B-DF9787E6B8B8}

8.1.1.24 {7AD771BB-B681-4659-B7FA-223FCB1FDF56}

8.1.2.8 {55C574CA-8D71-46F1-9897-98DAE55C0394}

8.1.3.17 {10D2A154-D221-4455-8426-E67D12C092F9}

8.1.4.19 {41CEFD25-0D33-44EA-A19C-5A1EBABFC041}
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To remove SMART Board
software 8.x

1. Open a Command Prompt window.

2. Type the following command (including quotation marks):

"C:\Program Files\Common Files\InstallShield\Driver\8\Intel 
32\IDriver.exe" /MProductCode /l1033 /s /z-AddRemove -
RemoveReg /f1"path to the setup.iss file\setup.iss"/
f2"destination path for the uninstall log file\uninst.log" 
/qn

NOTE
To automate the removal of SMART Board software, you can apply the 
command in a batch file as a startup script.

3. Press ENTER.

Removing SMART Board Software 9.x
SMART uses the Windows Installer 3.1 installation utility to install SMART Board 
software 9.x. To view the list of standard msiexec mode parameters, see page 19.

Performing a Default Removal of SMART Board Software 9.x 
from a Command Line
Before you can perform a default removal, you must obtain the product code for your 
version of SMART Board software. You can find your Product Code value in the 
following table:

NOTE
Include the braces—“{” and “}”—when entering a Product Code value in the 
following commands.

Software Version Product Code Value

9.0.1.57 {D2EC1505-9F11-4A94-9644-DCD0299DE491} 

9.1.0.40 {BD6516BA-2314-4F2C-9ECD-29BCB1074AFB}

9.1.3.47 {8D757887-9CD3-4F97-9873-E049E1C264CE}

9.1.4.51 {EE2A5345-CBE2-4932-83B0-D628D0D24AF8}

9.5.x.x {B72EB184-2A42-4B3C-8F8F-D7EF163829B4}

9.7.x.x {46486451-E60F-42C3-92D7-796D8594688A} 
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To remove the software
silently

1. Open a Command Prompt window.

2. Type the following command:

msiexec.exe /x"path to .msi"\SMART Board Software.msi" /qn

OR

Type the following command:

msiexec.exe /x[ProductCode] /qn

3. Press ENTER.
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Removing SMART Notebook 10
You can use standard Windows Installer user interaction parameters, such as those in 
the table on the previous page for removing SMART Board 9.x software.

Before you can perform the default removal procedure, you must obtain the product 
code for your version of SMART Board software. You can find your Product Code 
value in the following tables.

NOTE
Include the braces—“{” and “}”—when entering a Product Code value.

SMART Notebook Product Codes

SMART Product Drivers Product Codes

Software Version Product Code Value

10.0.124.0 {3E926B45-3748-40F9-8A30-99B225E1D2E5} 

10.0.126.0 {F581DF68-CAE9-4064-A6CD-705D95D1C756}

10.0.132.0 {F581DF68-CAE9-4064-A6CD-705D95D1C756}

10.0.187.1 {F581DF68-CAE9-4064-A6CD-705D95D1C756}

10.1.253.1 {D836B93F-3030-4047-99D3-65304A25839A}

10.0.517.2 {A51CDA36-B81D-4934-9C9D-B649A0DBF4CD}

10.0.596.3 {5C98A4FE-1F42-4F02-B738-F32886AE5467}

10.0.631.3 {5C98A4FE-1F42-4F02-B738-F32886AE5467}

10.6.94.0 {0A0719F0-AD56-42BA-B68C-EFFC330B6F13}

10.6.140.1 {47E6A509-37B7-4440-A252-7031E9A898D7}

SMART Product 
Drivers Version

Product Code Value

10.0.124.0 {FF7A64AB-214A-47D1-95E7-742BCBA7F6C9}

10.0.131.0 {FF7A64AB-214A-47D1-95E7-742BCBA7F6C9}

10.0.163.1 {FF7A64AB-214A-47D1-95E7-742BCBA7F6C9}

10.0.165.1 {FF7A64AB-214A-47D1-95E7-742BCBA7F6C9}

10.0.186.2 {FF7A64AB-214A-47D1-95E7-742BCBA7F6C9}

10.0.188.3 {FF7A64AB-214A-47D1-95E7-742BCBA7F6C9}

10.0.232.4 {FF7A64AB-214A-47D1-95E7-742BCBA7F6C9}
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Adobe Flash Player ActiveX Control Product Code
{922E8525-AC7E-4294-ACAA-43712D4423C0}

Microsoft Visual C++ 2008 SP1 Redistributable Product Code
{9A25302D-30C0-39D9-BD6F-21E6EC160475}

Handwriting Recognition Language Package Product Codes
See Handwriting Recognition Language Installation Packages on page 6 for product 
codes.

10.0.255.5 {FF7A64AB-214A-47D1-95E7-742BCBA7F6C9}

10.0.314.5 {FF7A64AB-214A-47D1-95E7-742BCBA7F6C9}

10.0.392.6 {00C68967-9790-40DA-86F7-FDB248A5CDB1}

10.0.528.7 {AA9C1126-50DD-4993-9CDC-0BED8167293C}

10.0.532.7 {984EAE92-6043-451A-B786-9327FF165310}

10.6.48.0 {2623A1E3-478A-4F4A-A522-3A3D784A0C9C}

10.6.106.1 {487F1117-8BDE-4518-A798-015172AE0410}

10.6.175.2 {333B0B76-FC96-4C51-9AF6-B6EFA15ACE99}

SMART Product 
Drivers Version

Product Code Value
 



Appendix D

Customer Support
Online Information and Support
Visit www.smarttech.com/support to view and download user’s guides, how-to and 
troubleshooting articles, software and more.

Training
Visit www.smarttech.com/trainingcenter for training materials and information about 
our training services.

Technical Support
If you experience difficulty with your SMART product, please contact your local 
reseller before contacting SMART Technical Support. Your local reseller can resolve 
most issues without delay.

NOTE
To locate your local reseller, visit www.smarttech.com/where.

All SMART products include online, telephone, fax and e-mail support:

Online www.smarttech.com/contactsupport 

Telephone +1.403.228.5940 or
Toll Free 1.866.518.6791 (U.S./Canada)
(Monday to Friday, 5 a.m. – 6 p.m. Mountain Time)

Fax +1.403.806.1256

E-mail support@smarttech.com 
 

http://www.smarttech.com/support
http://www.smarttech.com/trainingcenter
http://www.smarttech.com/Where
http://www.smarttech.com/contactsupport
mailto:support@smarttech.com
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General Inquiries

Registration
To help us serve you, register online at www.smarttech.com/registration.

Address SMART Technologies
3636 Research Road NW
Calgary, AB  T2L 1Y1
CANADA

Switchboard +1.403.245.0333 or
Toll Free 1.888.42.SMART (U.S./Canada)

Fax +1.403.228.2500

E-mail info@smarttech.com 
 

mailto:info@smarttech.com
http://www.smarttech.com/registration
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